5-1-2005


Johnson & Wales University - Charlotte

Follow this and additional works at: http://scholarsarchive.jwu.edu/clt_newsletter

Repository Citation
http://scholarsarchive.jwu.edu/clt_newsletter/9

This Newsletter is brought to you for free and open access by the University Libraries at ScholarsArchive@JWU. It has been accepted for inclusion in JWU Library Newsletter - Charlotte Campus by an authorized administrator of ScholarsArchive@JWU. For more information, please contact egearing@jwu.edu.
Student Survey Results

Below is a summarized report of the responses received from students regarding the general library survey conducted in March. As the library director, I have taken a moment to respond to concerns directly (my comments are in italics).

Student Responses

• The largest group of library users among students (48%) reported using the library a few times per month (as opposed to daily, never, etc.).

• 79% of students reported attending a library instruction session with 84% of this group agreeing or strongly agreeing that this session provided valuable information.

• Library databases were our most heavily used resource by students at 83% followed by books at 60%.

• Common problems reported with library use included lack of book resources, hours, and various isolated computer-related problems. The library currently has plans to nearly double the book resources of the library by next year. This will be accomplished through the acquisition of 6,500 books from the Charleston campus and the acquisition of thousands more through collection development. Library hours will be increased next year as well. New hours for the 2005/2006 academic year will be as follows: Sunday, 1 – 8 p.m.; Monday – Wednesday, 8 a.m. – 10 p.m., Thursday, 8 a.m. – 8 p.m., Friday, 9 a.m. – 4 p.m., Saturday, 12 – 4 p.m. Some of the computer issues may relate to the difference between the computers in front and those in the lab. The front computers are for research purposes. Full functionality (for typing papers, etc.) is available in the library computer lab.

• Only 12% of the students indicated reading the newsletter. As of March we have begun placing copies on a table at the entrance to the library. We are already seeing a wider distribution as a result.

• 72% of the students indicated strong or very strong agreement that the library is service-oriented. Only 6% disagreed or strongly disagreed.

• 59% of the students indicated that the library always has what they needed to get their papers or projects completed. We hope to increase this percentage next year. We are continuing to build our resources and to find new ways to reach you through your classes. Please remember that, if you can't find what you need, you may always seek assistance at the reference desk.

• For things they liked most about the library many things came out. Some items that came up repeatedly were computers, the staff, the location, free printing, and a quiet atmosphere.

• When asked what they liked least about the library 64 students responded with comments. 29 indicated the hours (with later hours and Saturday hours being the most prominent concerns) and 21 indicated the book resources. Again, we are listening and making adjustments accordingly. Please refer to my comments above about new resources and hours for next year.

• When asked the one thing that the library could do to improve students again most prominently brought up the need for more book resources and extended hours. Again, hours will be extended into the evening and Saturdays will be added next year.

Richard Moniz
Faculty and Staff Survey Results

Below is a summarized report of the responses received from faculty and staff regarding the general library survey conducted in March. As the library director, I have taken a moment to respond to concerns directly (my comments are in italics).

Faculty/Staff Responses

• Unlike students, faculty/staff reported slightly different use of the library with a split of 26% saying they use the library once per week and 26% saying they use it a few times per month.

• Faculty/staff self-reported use of resources was more balanced than student usage (which showed much greater use of databases than all else). 55% report using books, 55% report using journals/magazines, and 59% report using databases.

• One faculty/staff member expressed passionate concern about how the videos were integrated into the collection and one about the lack of business-related resources. There were several other comments about book resources as well although, unlike students, most faculty/staff also indicated an awareness of plans already in place to work on this (through collection development and getting the books from the other campuses). The library committee put the integration versus the separation of videos and DVDs to a vote. While the vote was close it was decided to continue integrating the videos into the collection. This allows for better physical browsing by topic. A faculty member can utilize the online catalog at any time to retrieve lists of videos by limiting according to that parameter. If they need help in doing so they can call or stop by the library at any time and we’d be glad to assist them.

• 94% of respondents indicated reading the library newsletter.

• 84% of the respondents indicated agreement or strong agreement with the statement that the library was service-oriented.

• Comments relating to what faculty and staff like most about the library were dominated by satisfaction with interactions with the library staff. While this was a positive finding the library staff hope to continue building relationships with faculty (and other departments) in the future. We, too, have experienced this as a very positive relationship. We are especially appreciative of the work done by the faculty members of the library committee this year and that begun by the faculty and staff serving on the information literacy committee.

• Some faculty comments related to how the library could improve also singled out hours and the need to increase the size of the collection. As stated in response to student concerns... This will be accomplished through the acquisition of 6,500 books from the Charleston campus and the acquisition of thousands more through collection development. Library hours will be increased next year as well. New hours for the 2005/2006 academic year will be as follows: Sunday, 1 – 8 p.m.; Monday – Wednesday, 8 a.m. – 10 p.m., Thursday, 8 a.m. – 8 p.m., Friday, 9 a.m. – 4 p.m., Saturday, 12 – 4 p.m.

Richard Moniz
**Farmer’s Markets and Pick-Your-Own**

Red ripe tomatoes, fresh sweet peaches, green leafy lettuce, and sweet delicious strawberries are just a few of the delights found at farmer’s markets and at local pick-your-own farms throughout the summer. Here you can buy fruits and vegetables that are ripe and ready to eat.

The Charlotte region is home to numerous farms where you can find everything from vegetables, fruits, herbs, to flowers. Choose a farm and pick fresh strawberries during the early part of summer. Then, return again later in the summer to get fresh tomatoes or even corn on the cob. In the April 20th Food Section of The Charlotte Observer, you can find an excellent list of the farms listing their specialties along with locations and times of operations. This list is also available online at: [www.charlotte.com/mld/charlotte/living/food/](http://www.charlotte.com/mld/charlotte/living/food/). It is best to call ahead to make sure items are available and the fields are open.

Farmer’s markets can be found in Charlotte and the surrounding region. Watch for signs or lists in the newspaper advertising the locations. Many of the markets are open year round with each season bringing different vegetables and fruits. Here you can talk with the farmers as you shop for produce, herbs, and flowers.

Whether you choose to go to a pick-your-own farm or to a farmer’s market, you will find fresh produce, herbs, and flowers that you can take home and enjoy for your next meal. Listed below are some cookbooks that are especially geared towards the foods you can find at the farmer’s market.

Books:
- *Fresh from the Farmers’ Market* / Janet Fletcher, TX801.F5597 1997
- *From the Farmer’s Market* / Richard Sax with Sandra Gluck, Strope TX715.S2753 1986
- *Gourmet’s Fresh from the Farmer’s Market to your Kitchen* , Strope TX715.G7147 1999
- *Better Homes and Gardens Farmer’s Market Cookbook* , Strope TX801.H45 1993

Jean Moats

---

**Waterlogged: The History of Women’s Bathing Suits**

When sea bathing became fashionable in the Victorian Era, no woman would have consented to wear the tiny suits that many females unabashedly don today. In fact, up until the early 1900’s bathing suits were extremely similar to a woman’s normal clothes.

When swimming in the sea caught on with women in the 1700’s, showing one’s ankles was considered indecent. As a result, women wore extremely modest beach clothes—in fact, they wore bonnets, shawls, and their dresses were floor length to hide their legs. How did they keep the dresses from floating up while they swam? They sewed weights into the hems!

The beach did not lose its appeal in the 19th century, but bathing clothes were still nothing like they are today. Women still wore gloves, bonnets, scarves, and kept their legs and ankles covered. By the 1860’s skirts gave way to more practical bloomers.

In the 1890’s the floor length bathing suit bit the dust; women predominantly favored garments that fell to their knees and elbows. These outfits were often made of baggy flannel or wool.

In 1910 the trend switched from baggy suits to outfits that would not leave the wearer quite so waterlogged (can you imagine how much water a wool bathing suit would hold?) Sleeves were removed from most and designs became more form-fitting, but knee length shorts were still the norm.

By the 1920’s women’s bathing suits finally came to resemble the one-piece suits of today’s standards. The suits were finally made out of skin-tight material to prevent water from getting caught inside. The long pant legs also went the way of the dodo—the lower part of the suits fell only to the lower hip (oh my, the scandal!)

*Information taken from The History of the Fashionable Bathing Suit* by Joanne Haug

Sarah King
MLA is a writing style bound by a set of guidelines and rules intended to enable a reader to easily locate source information. The layout of the MLA paper requires that a specific format be followed. More specifically, a properly formatted MLA paper will maintain the following characteristics:

- line spacing should be double spaced throughout the entire paper,
- each page should have a header which includes your last name and page number,
- margins should be 1 inch on all sides of the paper, and
- font should be 12pt Times New Roman.

These guidelines are simple to follow, however, formatting your document accordingly can get tricky at times. Below are some helpful tips and shortcuts to use next time you prepare your MLA paper using Microsoft Word.

Amy MacCabe

**LINE SPACING**

- Step 1: Select the text which needs to be double spaced (tip: keyboard command Control + A will quickly select all text in the document)
- Step 2: Select the “Format” menu and choose “Paragraph”
- Step 3: Within the “Paragraph” dialogue box, change the line spacing option to double
- Step 4: Choose “Okay”

**SETTING MARGINS**

- Step 1: Select the “File” menu and click the option for “Page Setup”
- Step 2: Within the “Page Setup” dialogue box, make sure the “Margins” tab is selected
- Step 3: Change the top, bottom, left and right margins to 1”
- Step 4: Choose “Okay”

**PAGE HEADERS**

- Step 1: Select the “View” menu and click the option for “Header and Footer”. Placement boxes for the header and footer will appear on your document
- Step 2: With your cursor inside the header placement box:
  - type your last name and press the space bar on the keyboard
  - select the insert page number button on the header and footer toolbar
- Step 3: Select the “Align Right” button on the formatting toolbar
- Step 4: Select the “Close” button on the header and footer toolbar

Note: Your last name and consecutive page numbers will now appear at the top right hand corner of each page
**New Books**

**Business/Marketing/Fashion/Hospitality**
- Cases in Human Resource Management in Hospitality
- Rich Dad's Guide to Investing
- Hospitality Cases in Marketing and Operations
- Rich Dad Poor Dad What the Rich Teach Their Kids about Money
- Understanding Textiles
- Brief Accounting Dictionary
- Kaplan CPA Review

**Other**
- The Origins of the Southern Middle Class, 1800-1861
- Rich Dad's Cashflow Quadrant
- Rich Kid Smart Kid
- Student Success in College
- Inventions and Discoveries
- Oxford French Dictionary
- Jack Welsh Winning
- Encyclopedia of Environmental Issues (3 volumes)
- The Plagiarism Handbook
- 140 Great Fashion Designs 1950-2000
- Chicken Soup for the College Soul (2 copies)
- A House Divided Sectionalism and Civil War 1848-1865
- Battle Cry of Freedom The Civil War Era
- Down and Out in Paris and London

**Culinary Arts**
- Always in Good Taste: The L.J. Minor Story
- The Kitchen Book and The Cook Book
- Letters to a Young Chef
- Frank Stitt's Southern Table
- Food Network Kitchens Making it Easy
- The Holidays
- The California Heritage
- The Complete Chicken
- Cakes and Cowpokes
- Classics from a French Kitchen
- American Bistro
- Food: An Authoritative and Visual History and Dictionary of the Foods of the World
- American Cooking: New England
- Women of Taste
- Last Dinner on the Titanic
- Jasper White’s Cooking from New England
- Pacific Flavors

**DVDs**
- Unsolved History Roman Colosseum
- Seven Wonders of Ancient Rome
- Hot Planet Cold Comfort

---

**The Carolina Insider:**

**Carolina Raptor Center**

Visit the Carolina Raptor Center to see one of this country’s most extensive collections of birds of prey. Located just north of Charlotte in Huntersville, you will be able to see eagles, falcons, hawks and owls from just a few feet away.

The Carolina Raptor Center (CRC), a non-profit organization, has received more than 9,000 injured and orphaned birds of prey since its founding in 1980. More than half the birds brought to the center are eventually released back into the wild, with some having migrated as far as Peru. Non-releasable birds remain in captivity as teaching birds and adoptive parents. The CRC website includes a Rescue link, which explains what to do when an injured raptor is discovered and what happens when a raptor comes to CRC.

Your visit will begin in the Edna S. Moretti Education Center, where there are some educational displays and a gift shop. After leaving the education center, you will stroll along the exhibit trail that winds through 47 acres of forest and where 23 species of raptors are on display. At each cage you will be able to read about the ecology, natural history, and conservation of the birds. For many, the highlight of the trail is a chance to view Golden and Bald Eagles in the enormous eagle aviary, the only one in the Carolinas.

For more information call (704) 875-6521 or check out the Carolina Raptor Center website at [http://www.carolinaraptorcenter.org/](http://www.carolinaraptorcenter.org/) where you will find more information on planning a trip or to find many opportunities to volunteer.

Doreen Anglis